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Introduction 
Using I Can Present is a great way to engage students in all 
curriculum activities and an excellent aid for improving your 
speaking and presentation skills, in any language. 

• You can create and film your own presentations, training or information videos,
quickly and easily and then send them to colleagues or post them on social
media sites.

• Use green screening to add pictures in the background or create a weather
forecast.

• It’s easy to import your own pictures and PDF images

• Add your own script  into the tele-prompt which automatically scrolls as you
record your presentation.

• Enter the script in any language.

• Add symbols onto a slide. A variety of symbols are provided for various
presentations.

• Add watermark, news ticker, date and time.

• Optional recording studios. green screen, side by side and picture in picture

• Use PDF files from PowerPoint or Keynote for example.

• Movies can be exported or shared directly to Twitter, or to iTunes or iMovie,
where they can be prepared for publication for use on websites, entrance hall
presentation screens, send to colleagues and many more.

• Bring presentations to life with I Can Present.

• Oh and did we mention its really easy to use?

This guide is for Version 2 or later. 

Author © Roger Young MSc, Cert Ed
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System Requirements for I Can Present Version 2.2 - Mac 
A Macintosh running Mac OS 10.11 or later. 

Disk Space: Around 28MB of free hard disc space 

Memory: 2GB RAM minimum, preferably 4GB 

You are recommended to install the demonstration version before purchasing I Can Present.

This will allow you to test it with your system and devices.  

Additional Requirements 

A suitable USB web camera or DV camcorder*.  

NOTE: For smooth video you will require a web cam that supports frame rates of over 15 frames 
per second. It is preferable for smooth video capture to choose on that supports 25 or 30 frames 
per second, or wirelessly linked video camera capable of delivering a smooth live feed. Please 
check the manufacturers specifications. 

We recommend the use of a chroma key screen in order to realize the full potential of this 
software.  

You may require an external microphone should the recorded sound quality be an issue.  

Installing the Software 

You will need to have administrator access rights in order to install this software to your 
computer. 

• Download the software to your computer from our 
website; www.HamiltonBuhl.com

The download you get from the website is in the form of a standard Apple install file or dmg file. 

• Double click the .dmg file to run it.

This it mounts a disk image file to your computer. You will see this as a white coloured drive on 
your desktop and in the Apple finder, with the name I Can Present. This is a standard Apple disk 
image.  

• Double click the installer package called I Can Present.

• Follow the on screen instructions. The software will install to your applications folder and you
will be able to run and register the software.

By default, the application will be installed into the Applications folder.  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Getting Started 
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1. Create your slides 

Use the built-in image library or import you own 
backgrounds.

Add symbols, news ticker and watermark, for an 
‘authentic’ news broadcast feel

3. Finished! 

Watch your presentation 
and share with others.

Live Preview 

2. Film your presentation 

Film in front of a green (or blue) screen to 
allow the slides to appear behind the 
presenter

Read from the built in Teleprompter



Quick Start 

Launch the software by double clicking on the I Can Present application. 

• Note: If you are intending to record your presentation straight away then it is a good
idea to have your camera plugged into the computer and switched on before
launching I Can Present.

The Main Window 

The I Can Present main window has two different 
views: 

• The Slide Editor – Create and edit slides

• Recording Studio – Set up and record video

I Can Present opens initially in the Slide Editor. 

Getting Ready 
It’s a good idea to collect any picture resources you wish to use before hand. 
Good quality, high resolution images are preferable and will ultimately produce a 
better result. 

You can also prepare any text you wish to use in a word processor or text editor 
as it can be pasted directly into your I Can Present script pages. 

• Plug in your camera

• Launch I Can Present

• Import your pictures to the Backgrounds

• Select a slide in the timeline

• Click on the picture in the Backgrounds panel you wish to display.

• Select the Script tab in the tool panel on the right of the window

• Either copy and paste your script or type it in directly

• Select the Add Slide button, a new slide is added to the timeline

• Click the Backgrounds tab
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• Select the next picture to insert into the timeline. 

• Add the script. 

• Repeat for all your backgrounds 

• Select the Recording Studio button (top right)  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Recording 
• Select the camera you are going to use from the drop 

down list 

• Make sure the correct microphone is also selected 

• Once the camera is selected, you can then choose the 
layout you are going to use. 

Some of the best videos are created using the chroma key 
or green screen feature. We deal with this in a bit more 
detail later in this manual, but for this example we’ll just use 
the ‘split screen’ option as a green screen may not be 
available. 

• Select the ‘Split Left’ option from the drop down menu. 

• The video feed will 
appear on the left and 
first slide will be 
displayed on the right. 

• Use the slider to set the 
scroll speed of the 
example text 

• You can change the size 
of the text by dragging 
on the splitter bar 
between the script and 
image area of the window. 

• When everything is to your satisfaction, select the record button 

• You will see a 5 second countdown timer, and then you can start recording. 

• To go the second slide, just click the mouse on the video or autocue window. 

• Click stop when you have finished. 

• The video will playback to you 

• You can choose to Export at this point. 
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Creating and Editing Slides 

Slide backgrounds are the pictures you are going to use in the presentation. A few are supplied 
as examples but we’d really want you to use your own pictures. 

Importing them is really easy and allows you to create a more personal presentation. You can 
import most types of pictures, even if they are PDF files, to use in the background. 

In this version you can also import PDF files into the background. 

Make sure the pictures you choose to use are as high a quality as possible as these will display 
much better in your video presentation. 

Adding Slides 

By default there will be one blank slide already in the slide view. The 
example below has two slides and the currently selected slide has a blue highlight. 

• Click the Backgrounds button to select the backgrounds library. 

• Scroll down to find the background you wish to use. 

The image you choose will be added to the currently selected slide.  

• Click the Add Slide button to add a new slide.  

A new slide is added to the timeline and automatically becomes 
selected. Its contents will be displayed in the preview area. 

To change the background, just click on another picture from the 
backgrounds tool panel. 

You can reorder slides in the timeline just by selecting one and 
dragging it to a new position. 
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Deleting Slides 

 

Select the slide in the timeline that you wish to delete. 

 
Either click the Remove Slide button or press the Backspace or Delete key. The slide will be 
removed from your project. 

If you have made a mistake and decide that you did not want the slide deleted, then it can be 
easily restored as I Can Present supports multiple undo and redo. This can be accessed through 
the Edit menu or by using the keyboard shortcuts; 

⌘Z : Undo   ⇧⌘Z  : Redo 
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Importing Pictures 
I Can Present lets you import your own pictures to use in your 
presentations. 

You can either drag and drop pictures onto the Backgrounds 
panel or Click the Backgrounds button in the Tool panel 
to select the background browser.  

• Click the Import button. 

A File Open dialogue will prompt you to navigate to the 
location of the picture file that you wish to import. 

• Select the file in the file browser dialogue and click 
Import. 

To ensure that your image is displayed with the correct 
aspect ratio in your presentation, you will need to select 
the region of your image that you wish to display. 

The red frame shows the area that will be used in your 
imported image.  

Dragging the frame with the left mouse button allows 
you to move the frame to the region you require. 

The handles in each corner of the red frame allow you to 
resize the area to be displayed. The aspect ratio will be 
maintained as you do this. 

• Click Import to finish importing the image. 

The image will be added to the library for this project only and 
will be saved with the project.  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Import from PDF 

You can import PDF files to use as backgrounds for your presentation. This is especially useful 
as it allows you to export and use files from Keynote and PowerPoint presentations for example. 
Both these applications can save the slides out in PDF format and are usually slides are usually 
orientated landscape making them ideal for including in I Can Present presentations. 

• Click the Import button

• From the browser window that now opens,
navigate and choose the PDF you wish to import to
your presentation.

A tool sheet opens where you can opt to either Fit or 
Fill the file to the slide. The results of which are 
shown below; 

A new slide will be automatically created for each ‘page’ of the PDF that is imported. 

Chroma Key Screens

!

Getting the Best From Your Screens

How to get the best results

Screens will need to be carefully ironed to remove 
creases. Use an iron with the temperature set for ‘cotton’. 
Please test on a small area of fabric at the edge of the 
screen, before commencing ironing.
Screens may be hung by inserting dowels in the hems top 
and bottom and/or by  hanging them from the loops sewn 
to the screen.
The screen needs to be uniformly lit, shadows on the 
screen will give poor results. You do not need to use 
studio lights daylight will suffice, but lighting is always an 
option.
Get the person or subject to stand away from the screen 
in order to avoid shadows.
Make sure the person is well lit but not directly  from the 
front, trial and error is really the only way to get the best 
for your particular location.
Ensure the person or subject is not wearing anything that 
includes the colour of the screen.

‘On Location’

By using our chroma key 
screens and I Can 
Present, you can now 
appear to be on location 
anywhere in the world. 

In I Can Present you can 
choose any pictures to use 
as your backdrops and 
then film your presentation 
in front of the chroma key 
screen. Immediately it 
looks as though you are 
actually there.

The award winning 
animation software I Can 
Animate also supports 
chroma key compositing.

Our high quality green screen 
fabrics are highly saturated 
and accurately colour-
balanced making them ideal 
for chroma key compositing. 
The standard screens are 
approximately 3m x 1.8m, 
sewn on all four sides and 
have loops to allow for 
hanging.

3.0m (approx) 1
.8

m
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p
p

ro
x)

Subject

Light

Light

Light

Camera

Green Screen

Lighting Diagram

You should not beed to got these lengths in lighting, but this is how a set 

may be lit ifor optimum results.

Original PDF Fit Fill
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Writing a Script 

I Can Present has an inbuilt tele-prompt allowing you to enter a separate script for 
each slide.  

Text can be entered in any language, and may also be cut and pasted from another application. 

• Click on the Script button in the Tool panel. 

An empty editable frame will appear in the Tool panel on the 
right. 

If you have already typed your text for the slide you are 
creating into a word processor, then copy and paste it into 
the teleprompter otherwise just type directly into the script 
frame.  

The text should contain information you are going to present 
for the currently displayed slide. This can be a script, 
questions or prompts, depending on your presentation. 

Each slide can have its own script.  

If you choose another slide from the Timeline, the script panel will change to display the 
appropriate script for the new slide. 

The script will be used in the teleprompter and will automatically scroll when you use the 
Recording Studio. How this is controlled is dealt with in the section on the Recording Studio 
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Adding Symbols to a Slide 

Symbols can be added to any slide and are available through the 
Symbols library in the tool panel. 

To add a symbol: 

• Click the left hand mouse button on the symbol you 
wish to use and drag it onto the slide. 

To move a symbol: 

• Click and drag it to a new location. 

Some symbols will animate once they have been dragged onto the 
slide. 

Deleting a Symbol 

• Click to select the symbol and drag the symbol off the 
slide. 

Changing the Symbol Size 

The size of the symbols placed on on an individual 
slide can be changed.  

Click on the Symbol Size slider and drag it to the 
right to increase the size of the symbols and to the left to decrease the size. 

Some of the symbols can be edited, for example temperature. Once the symbol has been 
dragged to the slide, double clicking it allows you to edit the text in the symbol. 

The editable symbols are Temperature, Wind Speed, Labels and UV.Editing Symbols 

Editing Symbols 

Some symbols can be edited, for example temperature symbols.  

Once the symbol has been dragged to the preview window, double clicking it allows you to edit 
any text in the symbol. 

The editable symbols are Temperature, Wind Speed, Labels and UV. 

Temperature  

• Drag and drop the temperature symbol onto the slide. 

By default temperatures are displayed in degrees centigrade. 

I Can Present can be reconfigured to use a temperature range in degrees 
Fahrenheit. If installed to a computer with region set to US the display will be in degrees 
Fahrenheit. 
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Double click the temperature symbol, and type in the value you require. 

  

 The colour of the symbol will change according to the temperature you type in. 

Temperature Scale

Left and Right Justified Pin Labels 

These labels have a drop pin that can be placed at a particular location. 
When you then double click on the label’s text it will become highlighted 
and you can then enter the text of your choice. 

Wind Speed 

The wind speed symbol can be changed in a similar way to all other editable 
symbols. 

1. Drag and drop the wind speed symbol onto the slide. 

2. Double click on the symbol, you can now enter your wind speed. 

The symbol can also be rotated to show the wind direction. 

3. Move the mouse pointer over the tip of the arrow, a double headed arrow will 
appear. 

4. Click and hold down the mouse button on the direction arrow, and rotate it until it 
points in the required direction.Pollen 

Pollen 

The pollen symbol shows the level of pollen in the air. There are four levels of pollen count that 
you can place onto your slide. 

  

Low Moderate High Very High
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UV Categories 

The UV symbol also has an editable field that is edited in the same way as the 
other symbols.  

This symbol also changes colour depending on the values entered. 

The UV index shows the risk associated with being outside in the sun with uncovered and 
unprotected skin. This is normally either shown as a coloured symbol or numerical value or both. 

The range for UV symbols is shown below; 

It is important however to access risk levels, that you know your skin type. 

WARNING : The table below is only a guideline and you should seek professional advice on your 
skin type to ascertain your risk. You should always take adequate protection against damaging 
your skin through exposure to UV. 

Guidelines for UV Risk

BBC Sun Index

Category UVI range Colour
Low 
Moderate 
High 
Very high 
Extreme

0 to 2  
3 to 5 
6 to 7 
8 to 10 
≥ 11

Green 
Yellow 
Orange 
Red 
Purple

Index White Skin 
Easily Burnt

White Skin 
Easily Tans

Brown 
Skin

Black 
Skin

low risk low risk low risk low risk

medium low low low

high medium low low

very high high medium medium

extremely 
high

high high medium

!  !  

!

!  !  

!

!

!  !

!  !
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Sport Symbols 

Other symbols can be used on the slides. We currently include a number of different sports 
symbol that can be used in conjunction with the backgrounds and other symbols. 

These can be accessed by clicking on the drop down menu in the symbols library and choosing 
form the Sports section of the list. 

Drag and drop the symbol you require onto the slide. The symbol can be repositioned on the 
slide by selecting it with the mouse and dragging it to the new location.  
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Project Settings 
 

Settings in this panel are applied to the whole 
presentation and will appear in the movie and recording 
studio. 

Show Watermark 
This will apply a watermark to one of the four selectable 
locations on your slides. The watermark is a graphic and could be a channel, 
group or school logo for example. It can 
be positioned; 

 Top left 

 Top right 

 Bottom left 

 Bottom right. 

News Ticker 
Selecting the checkbox to display the 
News Ticker will display any text you enter 
into this field at the bottom of the 
recording screen. A bullet point will 
separate text when you start a new line 
entering the text. 

Date and Time 
Selecting to display the Date / Time adds 
this information to the bottom of the screen in the 
recording studio. You can choose to display the 
current date and time by clicking on the Set Now 
button or type in a date, time or both, of your choice. 

!  
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Changing the Temperature Scale 

I Can Present is configured to start up using degrees centigrade, unless your 
computer is configured to the United States regional settings. 

To change the temperature scale: 

• Open the Project Settings panel. 

• Choose the appropriate item to switch between Celsius or Fahrenheit. 
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The Recording Studio 

Once you have created your presentation and written your script then it’s time to move to the 
Recording Studio. 

Click the Recording Studio button located to the right hand side of in 
the I Can Present toolbar. 

This screen allows you to set up the studio ready for you to begin recording. 

�
Recording Studio

The toolbar at the top of the recording studio displays a number of controls allowing you to 
choose how the recording will be laid out. The controls depend on which devices are available, 
for example either a camera and/or microphone. 

If no devices are available then you are reminded that a camera and/or microphone need to be 
selected. 

If your computer has an in-built microphone/camera then these can be used to record a 
presentation, otherwise you will need to plug an external camera/microphone into the appropriate 
ports. 
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Supported Cameras 

I Can Present should work with any Mac OS X supported USB webcam. 

 “What sort of web cam should I get?” 

There are a number of things to consider when trying to decide which web cam is best to use 
with I Can Present. You are capturing real time video so a camera with a good frame rate at a 
high a screen size as possible is preferable. Fifteen frames per second (15fps) at 640 x 480 
would be a minimum specification, preferably 800 x 600 at 15fps, would be preferable. Some of 
the more modern webcams offer a full 30fps at HD. You will need to check the web cam 
specifications on the manufacturers website. If the camera is capturing any slower than the 
speeds suggested here the video capture might be less smooth. 

We offer a number of cameras and our website, http://www.kudian.net, contains details of other 
cameras and how to set them up. 

You can also use a DV camera connected via a firewire connection or adapter. Additional 
hardware may be required for computers not fitted with a firewire port and you may need to 
install any drivers supplied with the hardware. Please cheque the camera manufacturers website. 

Please note that very few USB connected DV cameras currently have the ‘live feed’ feature that is 
required for a direct connection. Some cameras may be able to use a separate video capture 
device, but you would need to test with the trial software 

The software should detect these devices when they are plugged into the computer. They will 
automatically appear in the drop down lists for devices. If this does not happen you may find it is 
necessary to have the devices plugged in and switched on before launching the application. 

You could also use the HD camera in your iOS or Android mobile to capture your presentation 
using a really useful free App, EpocCam. There are details in this guide on how to do this 

Camera and Microphone 

You can use either a good quality web camera connected to the USB port of your computer or a 
Digital Video (DV) camcorder connected through the firewire port. It is a good idea to have the 
camera connected, and if necessary, switched on before launching I Can Present. 

You may also require an external microphone for good sound reproduction. 

You should ensure that your subjects are well lit before starting shooting, this is especially 
important if you are using a chroma key screen. 

When you click the Recording Studio button, you will see a different toolbar at the top of the 
window 

If the feed from the camera does not automatically appear in the preview, click on the drop down 
menu and choose the camera from the drop down list. 
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I Can Present will record in the highest 
quality that the camera is able to deliver and 
using an HD camera will give the best results 
however some HD webcams are unable to 
deliver HD at a high frame rate and will 
reduce the frames per second. The recorder video might then appear ‘jerky’ 

Frames per Second (fps) 

fps is a measure of how much information is used to store and display motion video. The term 
applies equally to film video and digital video. Each frame is a still image; displaying frames in 
quick succession creates the illusion of motion. The more frames per second (fps), the smoother 
the motion appears. Television in the U.K, for example, is based on the PAL format, which 
displays 25 interlaced frames per second. Generally, the minimum fps needed to avoid jerky 
motion is about 30. Some computer video formats, such as AVI, provide only 15 frames per 
second. 

Early motion picture films used 18 frames per second and the current standard for movie films is 
24 frames per second. A minimum of 15 fps is advised and the closer to 25fps, the better. 

Microphone Only 

If you do not have a camera then you 
can still use I Can Present to record the 
slides with just a voice over.  

Select the microphone you wish to use 
from the drop down list of audio devices. 

Only the audio input has a selected device
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Getting Your ‘Studio’ Ready to Record 

The toolbar at the top of the recording window is where we make changes to the recording 
settings. 

  

Video Input: Choose the camera to use for your recording from the drop down list. Unfortunately 
camera names are sometimes not the same as the model of camera, you may need to 
‘experiment’. 

Audio Input: Choose the microphone you wish to use for recording from the drop down list. This 
does not have to be the microphone in the video device you are using. 

Recording Layouts 

You can choose the layout of your recording from 
five different options, not all of them use green 
screen. 

Chroma Key 

The chroma key feature allows you to film your subject in front of a chroma key 
screen. The slides will appear behind the subject, creating a professional looking 
presentation. 

  

Chroma key is explained later in this guide. Unfortunately there are not a set of rules as all 
environments are different, but useful tips should make things easier. Click here for more 
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information on chroma keying. I Can Present displays a real time preview of the recording with 
the chroma key effect. This helps you to ensure that you have the correct set up prior to 
recording. 

• Select the Chroma Key layout from the toolbar  

• Click on the Chroma Key Settings button to open the chroma key settings panel. 

�
Chroma key settings

Where chroma keying is concerned, there is no easy solution such as ‘press button 1,2,3 and the 
chroma key just works.It’s a bit of trial and error, but can be very quick if you get the basics 
correct to begin with. Chroma keying is dealt with in its own section but let’s assume you’ve good 
lighting and are ready to continue.  

There are a couple of basic settings you can alter to achieve a good key. 

You may see that some of the chroma key screen is showing through as picture breakup.  

  

The poor keying has been enhanced in this image.
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This is down to there being ‘hot and cold’ areas (light and dark) on the screen caused by poor 
lighting or shadows. 

You can try to rectify this by correcting the lighting if possible to begin with. The more uniform the 
lighting the better. Make sure there are no large creases. The try using the Tolerance slider in 
the Chroma Key Settings panel. 

You should try to keep the value of the slider as low as possible. If this fails to have the desired 
result, you can try using the colour picker to get a ‘closer’ match to the colour that I Can Present 
thinks you are using. 

• Turn off the Chroma key by unchecking the option. 

  

• Click on the colour well to the right of the Colour Model selection. 

Apples colour picker will now appear 

• Click the magnifying glass selector tool or pipette on later versions of Mac OS X 

• Move the colour selection tool to an area of the green screen in the preview 
and click the mouse.  
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The colour in the colour picker will now show your choice. 

• Re-enable the chroma key. 

You may have to do this a couple of times, selecting a different area of the green screen to get 
the best key. The lower the setting of the tolerance slider the better. During this process you 
might need to introduce your ‘subject’ to ensure that they are not being keyed out, especially if 
they are wearing the same colour range as the backdrop! That feature can however be used in 
some presentations to great effect with chroma key suits, gloves, t shirts etc. In the example 
below the tolerance is set to high and the features of the presenter have been replaced with the 
background picture. 

 

There is more information on the other settings in the Chroma Key section of this guide. 

 I Can Present Green Screening - Mac OS X Page   28



Split Left - Split Right 

This option is similar to what you often see on 
TV when a presenter is doing an outside 
broadcast. In one part of the screen you have 
the presenter and in the other part the picture 
or weather forecast they are presenting 
about.  

The split screen can be either have the video 
on the left or right. No chroma key is used for  
this setting. 

Picture in Picture 

This option is similar in some ways to the Chroma key option but instead of the presenter being 
placed fully in front of the background slide they appear in a frame or the slide show appears in 
a frame. In the example below; 

•  The first picture shows Picture in Picture Video Framed. The slideshow will form the 
backdrop and the presenter is in a small wire frame. This can be positioned anywhere in the 
preview and can be resized to fill a maximum of 25% of the capture area using the handles 
that enclose it when it is selected.  

The second example shows Picture in Picture Slide Framed. The video feed forms the main 
part of the window and the slideshow is placed inside the wire frame. Again this can be 
positioned anywhere in the preview and can be resized to fill a maximum of 25% of the capture 
area using the handles that enclose it when it is selected. 

   

     

No chroma key screen is required for these features. This is ideal for using with Key Note and 
PowerPoint slides that can be exported and then imported in PDF format. This option can be 
found under the Save As menu in PowerPoint. 

Once the PDF file has been saved, you can import it straight into I Can Present as explained in 
the section dealing with Import from PDF. 
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Teleprompter speed  

  

Use the Scroll Speed slider to adjust the speed of the teleprompter text. 
Moving it to the right increases the speed while moving it to the left 
decreases the speed.  
 
You should alter the speed of the scrolling text until you can comfortably 
read it as it appears in the rectangular box towards the top of the window. 

Changing the Size of Text 

Between the text area and the video preview are is a purple splitter bar. 
Position your mouse anywhere on this bar and you will see the pointer changes to a double 
headed arrow. 

  

Hold down the left hand mouse button and drag the splitter bar, to either the left or right to adjust 
the relative sizes of the preview and the text in the tele-prompt.  

This allows you to set the font size of the text to a comfortable size for reading. 

This does not affect the size of the exported movie. 

Effect 

The effects button opens a menu that allows you to apply either a black and white or sepia filter 
to your video. 

Leave Studio 

Clicking this button returns to the setup window. 
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Recording 

Everything is set and you are ready to record. 

1. Click on the red record button at the bottom of the window to begin recording. 

2. The countdown timer will begin counting down from five to zero so that you can be ready to 
start your presentation. 

�
Countdown Timer

Your first slide will appear in the preview and alongside it the script. The script will scroll up the 
right hand side of the screen.  

As the script enters the target box near to the top, begin speaking. When you get to the end of 
the script for the first slide the script prompt will stop and will not continue on to the next slide 
until you press the left hand mouse button. The mouse pointer must be in the preview window 

When the left hand mouse button is pressed the presentation will continue to the next slide and 
the script for this slide will now begin to scroll up into the grey target box. You will need to do this 
for each slide. 

At the end of the presentation, press the Stop button. 
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Playback 

The Movie you have captured will be played back straight away. 

  

Once viewed, the presentation can either be Discarded, in which case 
you will go back to the Recording studio to reshoot your presentation or 
you can choose to Export your presentation by clicking the Export button. 

Exporting a Movie 

I Can Present exports movie files either as M4V movies or directly to 
iTunes and iMovie. 

*iMovie 10 and later, now longer allows us to export directly to the application form this version of 
I Can Present, however, the file is exported to the I Can Present folder in your  previous iMovies 
folder. (this will be created if it has been deleted. You can then either import it into iMovie in the 
normal way or apply the Update projects option from the File menu in iMovie 10. For more 
information please go to Appendix III or visit; 

 https://support.apple.com/en-gb/HT202853 

To export your movie: 

• Click the Export button.  
An export sheet will appear as shown: 
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• Click on the application where you wish to send your movie. 

• Choose a size of movie that you wish to export. If you are sending to iMovie then you 
should choose Large as this gives you the best resolution for editing. You can 
choose to export at a smaller size from iMovie after editing. 

• When you have made your choices, click on the Publish button.  
If you have chosen to export as a QuickTime MPEG Movie then a file save browser 
will open and you will need to enter a file name for export. Once you have done so, 
click the Export button. 

The movie will then automatically start to export to the selected application. If you share to 
iMovie, then you need to ensure that iMovie is not already running as iMovie only searches for 
new clips when it starts.  
 
The export progress box will open showing the progress of the movie export. Generally we have 
found that the export process takes up to the same amount of time as your recorded movie and 
the file size is around 12Mb per minute. 

For example; a typical 2 minute presentation will take up to 2 minutes to export depending on the 
speed of your computer with a file size of around 25Mb. 

When the export has completed, 
you can choose to Tweet your video 
to us, as we would love to see them, 
or just close the dialogue window 
and return the the Recording 
Studio. 
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Saving an I Can Present File 

You should save your project files regularly whilst creating it. 

Each project file saves the details for each slide, the background used, the symbols 
and their positions as well as any script.  

Note: the project files do not save any recorded video as this would make them very 
large. 

• Choose File > Save from the menu bar. 

Alternatively you can use the keyboard shortcut ⌘S. 

A Save As dialogue will open allowing you to choose the location to save and name the file. 

I Can Present files have the file extension .ksicp and can only be used by the I Can Present 
application for further editing. The I Can Present files are compatible with our PC version of I Can 
Present. 

Opening an I Can Present File 

Either: 

• Load the I Can Present application. 

• Either choose File > Open… or use the File > Open Recent submenu to choose a 
recently saved file. 

• If you select Open… a file browser window will open allowing you to navigate to and 
select the file you wish to use. 

• Highlighting the Open Recent option presents a list of files that have recently been 
saved from I Can Present.  

• Select the file you wish to open from the list. 

• It will then load into I Can Present and you can continue working. 

or 

• Double click on the I Can Present file. The I Can Present application will launch and 
then load the chosen file. 
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Preferences 
Preferences are accessed through the I Can Present/
Preferences menu  or the keyboard shortcut ⌘, 

Autosave 

Once a project has been saved you can set the 
Autosave feature to ensure that you do not lose your 
project should there be an issue with your computer. 
The default is every thirty seconds. 

Check for Updates 

You can also check for and download updates and again set when you wish this to be 
undertaken. 

 I Can Present Green Screening - Mac OS X Page   35



Chroma Key Explained 

Chroma keying is a technique for mixing two images together, in which usually a single colour 
from one image is removed, or made transparent, revealing another image behind it. The 
technique is also known by other names, green-screen, blue-screen, colour keying and colour-
separation overlay. Used extensively in the film industry for special effects, it is also seen 
everyday, such as in weather forecast broadcasting. The presenter appears to be standing in 
front of a large map, but in reality they are stood in front of a large blue or green background in 
the studio. Different weather maps are added on those parts in the image where the colour is 
blue or green. Blue and green are considered the colours least like skin tone.  I Can Present has 
been designed to allow the user to choose any colour to key against. 

The illustration demonstrates the effect that can be achieved. 

In reality the choice of chroma color is dependent on the colors used in the presentation your 
are shooting. For example if you are filming ‘presenters wearing green, using a green screen 
would mean that they too would disappear when the chroma key filter is applied. Mind you that 
could be fun! 

For the purposes of this guide we will refer to it all as green-screen. 
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Lighting 

  

The biggest challenge when setting up a green-screen is getting the screen evenly lit and to 
avoid both shadows and hotspots, (areas which are brighter than the rest of the screen). An 
evenly lit screen gives a narrow colour range to be replaced, resulting in much more accurate 
keying. If you have shadows, it would present itself as a darker colour to the camera and might 
not register as part of the matte. 

  

When choosing a chroma key screen, try to use materials which are not shiny. A shiny surface 
will have areas that reflect the lights making them appear too bright. It is better to choose a matt 
surface as this will diffuse the reflected light better and have a more even colour range. 

Object

Light

Light

Light

Camera

Green Screen

Hot Spot
Cold Spot

Shadows
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Colour Models 

I Can Present uses four different methods for calculating which colours should be used as the 
chroma key mask. These are: 

• Red 
• Green 
• Blue 
• From Colour 

The default setting for the colour models is From Colour. 

Red, Green or Blue  

These models all work in effectively the same way for each of the respective colours. If you know 
that the background is one of these colours then you can just select this colour model without 
having to keep using the colour picker.  

Advantages: 

• Is easier to use; you don’t have to manually select the chroma key colour and is less time 
consuming. 

• Maybe faster on older computers. 

Disadvantages: 

• The chroma key colour must be either red, green or blue and for best results the chroma key 
background has to be lit correctly. 

• Not good for screens that are creased, or poorly lit. 

From Colour  

This method requires you to use the colour picker to pick the background colour from the 
preview. 

Advantages: 

• You can choose any colour you wish for the chroma key. 

• Can give substantially better results. 

Disadvantages: 

• You need to manually select the colour using the colour picker. 

• Maybe slow on older computers. 

Once you have chosen the colour model suitable for your screen, use the Tolerance slider to 
increase or decrease the size of the matte. 
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Chroma Key - More Settings 

 You may find that some areas of the subject have disappeared or that some areas of the chroma 
screen are still visible.  

This can happen because; 

• The colour chosen for the key is also present in the foreground subject. 

• The colours in the foreground are very close to the one you have chosen to use as a key. 

• Or, as we have previously mentioned, lighting is poor. 

I Can Present has a control panel that allows you to try to get the best key for the subject you are 
using. Earlier we mentioned that the Tolerance slider can be used to great effect, but there are a 
number of other settings that you can control. We’ll remind ourselves of the tolerance slider to 
begin with; 

Tolerance  

This slider enables you to set a tolerance for the 
chroma key colour. Ideally you will want to set this to 
be as low as possible, whilst ensuring that all the 
background screen has disappeared. If you set it too 
high you may find that some of your foreground 
subject starts to disappear too.  

If you need to set it very high it is probably because 
your chroma key background is not evenly lit. 

Blend 

The Blend slider enables you to smooth off the edges of your foreground subject eliminating 
some of the jagged edges around the foreground subject. 

To get a better idea of this try selecting the Show Matte check box. Then drag the Blend slider 
up and down and you should notice the edges becoming slightly blurred. Remember to turn off 
the Show Matte check box to view the preview again. 

Despill 

One of the problems filming in front of green or blue screens is that the green light reflected from 
the screen can effect the foreground objects. This can often be seen as a green tinge around an 
object or reflections in shiny objects. Objects that do not have a clearly defined edges, such as a 
person’s hair, can be particularly affected; these become blended with the green, we call this 
spill. 

There is another issue which you might notice and that is glare. If there is a lot of green light 
coming into the lens of the camera it can reflect internally in the lens and can cause the whole 
image to have a slight green tinge, Despill will also remove this tinge. 
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To try to remove the spill I Can Present uses a very effective system controlled by the Despill 
slider.  

Try experimenting with the slider to see the effect. One of the downsides however is that when 
you drag the slider over to the right then the colour balance of the foreground image will change. 

Although Despill can be very effective, there is this side effect of changing the colour balance of 
the image. In many cases this is either not noticeable or you will find that the issue is far 
outweighed by the improvement of spill in the foreground subject. 

Should you require further details on Despill, then an excellent guide is Digital Compositing for 
Film and Video by Steve Wright – Focal Press 

Blur the Matte 

Despite having the blend facility when pulling the matte, I Can Present also offers the feature of 
artificially blurring the matte too. This can make the edge around the foreground subject blend 
much better into the background. Using the Blur Matte and Size of Blur sliders, a better blend 
can be obtained around the edges of the foreground subject. 

Blur Matte controls how intensely the matte is blurred and the size of the blur determines sets the 
blur radius, i.e. how big is the blur. In the example below, the object has ‘Blur’ applied to soften 
the edges. 

 Without Blur With Blur
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I Can Present Mobile 

You can now get I Can Present 
for your mobile device iOS 
(iPad) and Android. It’s a great 
addition to supporting this 
version giving you flexibility to 
undertake an  interview or 
presentation using the mobile 
device and incorporating it with 
your presentation. 

The following page has a 
pocket guide that you can print 
out and fold for reference. 

 We’ve placed a video on our 
website showing you how to fold 
this useful guide and a link to download the PDF directly. You’ll find it in the I Can Present 
section. 
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Appendix I 

Using a Mobile Device as the Camera 
You can use the HD camera in your mobile device to capture your presentation 
using a really useful App, EpocCam*. Please refer to the EpocCam website for the 
latest updates and software. 

HERE’S HOW YOU DO IT:  
ON YOUR MOBILE; 

Go to the Apple App store and search for EpocCam*. Download and install the App 
to your mobile device. 

ON YOUR LAPTOP OR DESKTOP;

Download and install the Mac OS X drivers from http://www.kinoni.com/osxdrivers 

(Mac OS X requires 10.6 or later) 

Both your Mac computer and iOS device must be connected to same WiFi network.  

Start the EpocCam application on your iOS device. 

Start I Can Present  
EpocCam will appear in the list of cameras available to the Application.

Select EpocCam, from the camera list in I Can Present and the mobile will now try 
to connect to the desktop computer. This may take a few seconds. 

Soon you should see video feed appear in 
the applications Camera options. You can 
find further information here; 

http://www.kinoni.com 

TROUBLE SHOOTING

WIFI CONNECTION DOES NOT WORK

Check you firewall settings. Your firewall application can block the traffic between 
PC and phone. 
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If you are using third party firewall software like Norton or F-Secure you need to 
configure them to allow Bonjour-service traffic on UDP port 5353. Also allow 
'KinoniSvc' to accept in- coming connections to TCP port 5055. 

*EpocCam is a third party application, with no technical support for it.
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Appendix II 

Links to Support Resources and Updates 

I Can Present – Support Resources and Updates 

The following web addresses may prove to be useful. We cannot guarantee that they are still 
active as web addresses change over time. 

The Met Office EUMETSAT BBC Weather 
GMTV Weather metcheck AccuWeather.com 
netweather.tv Mountain Weather Information Service 
MeteoGroup 

M4V Files 

The M4V file format is a video container format developed by Apple and is very similar to the 
MP4 format.  

M4V files may optionally be protected by DRM copy protection. 

An M4V file can be renamed to the more common extension of MP4 to be played on other 
media players if it is not protected content. 
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Appendix III  

Update projects and events from previous versions of iMovie in 
iMovie (2014) 

I Can Present is still using the old iMovie folder structure so when files are exported to iMovie, 
you should find an I Can Present folder within the iMovie Events folder in Movies. 

Movies/iMovie Events/I Can Present

You should be able to run the ‘Update projects and Events option from within iMovie, or just 
import the video file in the folder in the normal way to iMovie. The title of the file you have saved 
will be: 

  Untitled followed by the date eg Untitled 11-15-18.m4v

so its a good idea to save and name your project before recording and exporting. 

If you've ever used an earlier version of iMovie, when you first open iMovie 
(version 10.0 or later), you’re asked to update your existing iMovie projects and 
events. 

After you update your projects and events, copies of the original iMovie Projects 
and iMovie Events folders are left in place. The files in these folders can still be 
opened by previous versions of iMovie. If you don't want to use these files in the 
future, delete the folders. 

To update projects and events on external drives

1. Verify that the iMovie Projects and iMovie Events folders are
stored on the top-level of the drive.

2. Open iMovie.

3. Choose File > Update Projects and Events.

After the update 

After you update, your projects and events are placed in a new 
library, which you can see in the iMovie sidebar. 

• Your updated projects are in the Updated Projects event.

• If you previously shared or finalised any of these projects, those video files
will appear in the Finalised Movies event.
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In the Finder, an iMovie Library file is created alongside your original iMovie 
Theatre, iMovie Projects, and iMovie Events folders. 

!

The files in these folders can still be opened by previous versions of iMovie. If you 
don't want to use these files in the future, delete the folders. Learn more about. 

To update later 

If you choose Update Later, you can update projects and events by following 
these steps: 

1. Open iMovie.

2. From the menu bar, choose File > Update Projects and Events.

3. Click Update in the dialog that appears.

© 2016 Roger Young MSc
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